
BLANKRUPTER® 4.0 
 Quick Start 

 PROGRAM INSTALLATION 

 The steps to install your Blankrupter program; 

 1. Insert CD labeled Blankrupter Setup into your CD-ROM drive of your 
 computer. 

 2. From Start, select RUN 

 3. Type D:SETUP ( or the letter for your CD-ROM drive). 

4. Follow the on-screen instructions to complete the installation. 

 Technical Support and Registration 

 By Telephone  724 838-8993 (NWinds) 
 By Internet  Go to Help….register via internet 
  Follow the prompts. 
   Sales   BlumbergExcelsior 800-221-2972 ext. 565 

 REGISTRATION by telephone 

 When you first purchase Blankrupter 4.0, the program INCLUDES an evaluation period. 
 The program will be fully functional for 30 days. After this 30 day evaluation period, the 
 program will go into demo mode. In the demo mode, you cannot print any forms except 
 for the Voluntary Petition, Page 1. 

 If you are not satisfied and you have not registered the program with NWinds, you must 
 contact BlumbergExcelsior for instructions on returning the software. 

 When you call to register the program, NWinds technical support will ask you to open the 
 registration screen. This can be found by going to “Registration” from the “Help” menu 
 in the main screen. This screen will contain a code number and a computer number. 
 Give these numbers to technical support; in return, you will receive a seven digit 
 number to type into the Trigger Code Box. After you type in the number, choose the 
 “OK” button and a message will come up confirming that the program has been 
 registered. You can also use this registration screen to find the expiration date of the 
 evaluation period. 
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 SINGLE USER SYSTEMS 

 Once registration is complete, the program is fully functional on that computer ONLY.  If 
 you try to access the program through a network, the program will become functional 
 on that computer for 30-days, and then it converts to the demo mode. If the CD-ROM is 
 used to install the program onto another computer, the same thing happens, i.e., 30-day 
 evaluation period then demo mode. 

 Limited Warranty 

 BlumbergExcelsior, Inc. disclaims all warranties, express or implied, concerning the software 
 program. BlumbergExcelsior specifically disclaims any warranties of merchantability or 
 fitness for a particular purpose. In no event will BlumbergExcelsior, Inc. accept liability for 
 any damage, including consequential, indirect, or special lost profits, arising out of the 
 use or inability to use any software programs or other products.  As noted 
 BlumbergExcelsior’s damages will be limited exclusively to product replacement or 
 refund of purchase price. Some states do not allow the exclusion of implied warranties, so 
 the above exclusions may not apply to you. This warranty gives you specific legal rights 
 and you may also have other rights, which may vary from state to state. 
   

 
NEW TO VERSION 4.0 
 

  Dynamic MEANS TEST CALCULATOR with IRS and Census Bureau Data  
included in the database. 
  

  ▪ Determine Means Test “presumptions” in advance 
▪ Database refined to the county level in all Districts 
▪ Automatically determines “presumptions” and populates fields of OF 22A, B or C  
▪ If data changes, presumption will be revised and appropriate form completed     
▪ Avoids redundant entry of data 
▪ Avoids side calculations 
▪ Gathers Schedule I data for Means Test 
▪ Revisions to IRS & Census Bureau tables are easily downloaded 

 
New Bankruptcy Questionnaire, 12 pps. – print, or email to your clients to help them gather,  
organize and present you with their information in logical sequence. Click Miscellaneous  
Forms, then Other Forms.  
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 INTRODUCTION 

 Welcome to Blankrupter, the software program that processes and generates 
 BlumbergExcelsior Official Bankruptcy Forms on plain paper, using your personal 
 computer and printer. Blankrupter operates in the Microsoft Windows environment,  
 making data entry simple and straight forward. It automates the processing of  
 Chapters 7, 11, 12 and 13 bankruptcy forms, and includes the necessary 
 math calculations as well as the required mailing list. We believe that you will find 
 Blankrupter an easy-to-use, productive tool for processing bankruptcy forms. 

 Blankrupter has the following unique advantage: 

 • Easy to install and use 

 • Enables electronic filing 

 • Processes Chapter 7, 11, 12 and 13 Official Forms 

 • Automated Means Test 

 • Forms updated online as necessary 

 • Graphic forms generated on blank paper 

 • Six different mailing list print formats and three electronic formats 

 • Automatic math calculations 

 • Includes federal and state exemptions 

 • Client Questionnaire 

 • Spell checking 

 • Print preview 

 • Online help 
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SYSTEMS REQUIREMENTS 

 Blankrupter is designed to work on the personal computers with Pentium (or 
 compatible) chips, with a minimum of 25 MB hard drive space available with at least 32 
 MB RAM, Windows 98 or greater (Blankrupter is not supported under the Microsoft 
 ME operating system). 

 Any Windows supported printer can be used with Blankrupter. 

 NOTE: This instruction manual explains how to use Blankrupter software program 
 only. Please refer to the Microsoft Windows software documentation for instructions on 
 how to use Windows and the user manuals for your computer, mouse and printer for 
 instructions on using your hardware. 

 PROGRAM INSTALLATION 

 The steps to install your Blankrupter program: 

 1. Insert CD labeled Blankrupter into your CD-ROM Drive 

 2. From the “Start” button, select “Run” 

 3. Type D: Desktop4.0setup4.exe (or other letter for your CD-ROM drive) 

 4. Follow the on-screen instructions to complete the installation 
  

 

 

  
2 



 CHAPTER 1:  BASIC CONCEPTS AND THE MAIN MENU 

 Moving through the Data Entry Fields 

 To move from one field to another in your Blankrupter program, use your mouse to 
 click into the field. 

 Spell Checking the Data Entry Fields 

 To check the spelling of a data entry field, place the cursor in the desired field and select 
 Spell Check from the Tools menu. 

 Cut, Copy and Paste Feature 

 Like most Windows programs, the data entry screens in your Blankrupter program 
 enable you to cut, copy and paste information within the program and from other 
 Windows program and from other Windows programs. See your Windows manual for 
 additional instructions. 

 The Navigator 

 Each dynamic data entry screen such as the Schedules and Statement of Financial Affairs 
 have what is called a Navigator to enable you to go to the first, last, previous and next 
 entry in the database list as well as add, delete, save or cancel entries (see figure  below). 
 In addition, some screens contain a Navigator that enables you to add entries to the 
 database list. 

 Figure 1 Top 
                              First Entry 
        Previous Entry 
        Next Entry 
        Last Entry 
        Add Entry 
        Delete Entry 
        Save Entry 
   Cancel Entry  
  
 In addition, directly below the Navigation is an entry indicator. (Figure above) This 
 indicator shows where an entry is located in relation to all other entries (e.g., the 
 beginning, middle or end).  
 

Figure 1 Bottom 
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  The Main Menu 

 The Main Menu screen is a listing of a variety of program options. Each button on the 
 screen represents a different option in your Blankrupter software. Choose an option by 
 selecting the button with your mouse. 
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 The primary functions of each button are: 

 ICON OPTION    FUNCTION 

  

 

 

 

 

 

  

 

ATTORNEY/CLIENT 

VOLUNTARY PETITION 

SCHEDULES 

MISCELLANEOUS FORMS 

STATEMENT OF 
FINANCIAL AFFAIRS 

MEANS TEST 

MAILING LIST 

PRINT FORMS 

UTILITIES 

EXIT 

Access databases to add, edit or delete 
clients from databases. 

Enter information for the standard two-page 
form required for all bankruptcy filings. 

Access the Schedules Menu to select 
a specific schedule, enter property by type 
and print. 

Access the Miscellaneous Forms 
Menu to enter data and print various other 
bankruptcy forms. 

Enter financial affairs information and print 
the statement. 

Enter Means Test data. 

Access and print the mailing list to add unique 
entries at the top of the creditor mailing list, 
such as debtor’s name, social security number, 
taxing authority, debtor’s attorney, etc. 

Print all or selected form at one time and 
print the schedules instructions. 

Access system utilities to enter, edit or 
delete, Common Creditors; select 
printing options and exemptions. 

Exit Blankrupter 
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 Button Symbol 
 
  In the Blankrupter menu screens there are several different buttons with small symbols. 
  These signify specific options and data entry screens. For example, the 
  ATTORNEY/CLIENT button in the Main Menu displays an open file folder. This is the 
  standard Windows symbol for using directions. This program has additional unique 
  symbols. These are: 
   
 

SYMBOL        TYPE OF OPTION 
   
    Access a directory. 
  
    Access a data entry screen to complete a form. 
 
 

To access an additional menu. 
 
 

Mailing lists. 
 
 

Print. 
 
 

Utilities. 
 
 

Access a lookup table such as Exemptions and Common Creditors. 
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CHAPTER 2:  PROCESSING A BANKRUPTCY 

 Once installation is complete; you can begin to use your Blankrupter program. Each 
 firm processes a bankruptcy in its own way. Some attorneys write the information down 
 on worksheets and have their staff enter it, while others enter the information directly 
 while they conduct the initial interview. Some firms complete the Schedules first, while 
 others start with the Statement of Financial Affairs. Blankrupter is flexible. You can 
 begin the process with any form. This manual describes the process in the order that it 
 appears on the Main Menu. We will first describe setting up databases and clients, then a 
 Voluntary Petition  and so on. 

 Adding and Selecting a Database and Client 

 Blankrupter works on one database and client at a time. The database is ordinarily the 
 name of the attorney who processes a given bankruptcy. A law firm can have databases 
 for each attorney in the firm. The databases appear as sub-directories in the Bank 
 directory on the computer hard drive. Attorneys add clients to their own databases. Each 
 client listed in the database represents a different bankruptcy case. 

 Create a database for each attorney or staff member. Each time you begin working with 
 Blankrupter, first select the ATTORNEY/CLIENT button, then (1) add or select a 
 database and (2) add or select a client. You will not have the ability to access any other 
 part of the program ( except Utilities ) without first selecting a client from a database. 

 NOTE!  When you first begin using your Blankrupter you will be taken directly to the 
 ATTORNEY/CLIENT screen. You must first add a database and create a client or 
 select an existing client as described in the following section. 

 To Add a Database and Client (Figures 3 and 4) 

 1. From the Main Menu, select ATTORNEY/CLIENT. An Attorney/Client 
 Screen will appear listing your Blankrupter directory on the left (Bankwin), 
 and a clients box on the right (see Figure 2).  Be sure that the Bank directory 

 is highlighted and select the  button next to the directory to add 
 your database. 
 

   2.  A dialog box appears asking for a database name. Enter a name with 8 

        characters or less (no spaces). Select the                      button. 

 
   3.  A second dialog box appears requesting a client name. Type a client name (31 

        characters or less) then select the                     button. 

   4.  When asked if you wish to add default information about this new client, 
        choose YES or NO. This is basic information, every client (refer to Chapter 
        14 for more information on setting the default information). 
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5.   A series of data entry fields will appear on the bottom portion of the screen 

 including Leading Caption and Case Information (see Figure 4). This is 
 preliminary information for your bankruptcy filing. Enter the appropriate 
 information and select the button indicating whether the filer is an Attorney or 
 Non-Attorney Petitioner. 
  
   6.   Select the                     button on the bottom of the screen to save the data and 
         Exit to the Main Menu              , or select the button in the Clients box to 
 add another client to the same database. When you exit to the Main Menu, the 
 last client name you entered will appear in black on the Main Menu. You are 
 now ready to complete the forms for that client. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
       
      Figure 2 
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Figure 3 

               Accessing an Existing Database and Client 

               Before processing a bankruptcy, you must select a database and client. 

  1. Select the ATTORNEY/CLIENT option in the Main Menu. 

  2. When the Attorney/Client screen appears, double-click on the name of your 
database from the list under the Bank directory (located on the left-hand  

    corner of the screen). 

  3. Select a client name from the list of clients located in the Clients box on 
   the right. The Leading Caption and Case Information for the client you 
   selected will appear. 

  4. Select the              button at the bottom of the screen to exit to the 

   Main  Menu. The client’s name will appear in the center of the screen 
   above the Main Menu options. You are now ready to process a bankruptcy 
   for the client. 
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NOTE! If you need to enter a new client, select the      button in the Clients 

  section. 
 
  Processing a Voluntary Petition 
 
  The Voluntary Petition is the initial two-page form required for all bankruptcy filings. 
  When you select the VOLUNTARY PETITION option from the Main Menu, both 
  pages become available for you to enter data. The Voluntary Petition screen is called a 
  static data entry screen because it is a duplicate of the actual printed form. Filling in a 
  static data entry screen is like typing the form on a typewriter, i.e., you type in the actual 
  area using your keyboard. A major difference is that you have the word processing 
  capabilities not available on a typewriter. 
  
 

To Process a Voluntary Petition 
 
 

  1. Choose the database and client following the previous instructions and exit 
     to the Main Menu.  Your client’s name should appear on the Main Menu. 

  2. Select the VOLUNTARY PETITION from the Main Menu . The 
   Voluntary Petition data entry screen appears. 
 
  IMPORTANT NOTE!  The Voluntary Petition data entry screen looks like the hard 
  copy of the form. However, you cannot see the entire form on the screen at once. The 
  screen will automatically scroll as entries are made. Also, there is a scroll bar provided 
  on the right side of the screen. 
 
  3. Type in the required information. The cursor will move through the form 
   in a logical manner. 

  NOTE! There are various checkboxes and circles located throughout this screen 
  pertaining to type of debtor, nature of the debt, etc. Use your mouse to make selections. 

  4. When you complete page one, click on the red Page Two located on the 
   top of the screen. 
 

5. Enter the required information on page two. 
 

  NOTE!  If you are filing under Chapter 11, be sure to check the box indicating that 
  Exhibit “A” is attached. 
  

6. When you have completed both pages, print the Voluntary Petition or exit 
   to the Main Menu. To print, see Chapter3: Printing. The first time you 
   print, you must set up and align your printer. You may also select Print 
   Preview from the main menu to view the form before printing. When your 
   printer is correctly set up and aligned, select Print from the menu bar with 
   your mouse. Next, select Print from the menu selections using your 

10 



 
 
 
   mouse. To exit to the Main Menu, select Return from the menu bar using your 

mouse, and select Save Changes to save your data. 

                      7. If you are going to be processing your Bankruptcy via “Electronic Filing” 
 then you must fill out the page. This is used to create the debtor file used 
 in the Case Upload. 
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 Processing Schedules 

 NOTE! If you are not familiar with processing the schedules you can print the official 
 instructions. 

 1. Select PRINT FORMS from the Main Menu. 

 2.  Select SCHEDULES INSTRUCTIONS from the Print Forms screen. 
 (The button changes from dark to light when selected). 

 3.        Select the PRINT button. 

 Most of the Schedules are dynamic forms (i.e., can be any length).  The data entry 
 screens are different from the static form screens.  Each dynamic data entry screen 
 contains the Navigator (described in Chapter 1). The information required varies 
 depending on the type of bankruptcy being filed. A variety of options to complete the 
 data entry process are available, including checkboxes, pull-down selections, data entry 
 fields, and look-up tables.  The screen changes based on the selection you choose. 

 The Schedules Menu 

 Select Schedules from the Main Menu and a list of data entry screens appear.  The 
 Schedules Menu has five options: 

 Property (A, B, C) – To enter data pertaining to property in order to process Schedules 
 A, B and C. 

 Creditors, Debtors, Codebtors (D, E, F, H) - To enter data about creditors, debtors and 
 Codebtors.  Access a list of common creditors.  Complete the Declaration Concerning 
 Schedules. Process Schedules, D, E, F and H. 

 Income, Expenditures, Contracts and Leases (G, I, J) – To enter data pertaining to 
 income, expenditures, contracts and leases in order to process Schedules G, I and J. 

 Summary of Schedules – To view, edit and print the Summary of Schedules. 

 Exit – To exit the Main Menu. 

 Processing Schedules Pertaining to Property 

 1. Select PROPERTY (A, B, C) from the Schedules Menu. 

 2. A Property Screen appears (Figure 5).  First select a Category of Property 
 (Real or Personal). If you select Personal, the bottom of the screen will 
 change and ask for information required for Schedule B. 

 3. Select who the property belongs to (H, W, J, C that is, Husband, Wife, 
 Joint, Community) and type in a description and location of the property. 
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 4. If the property is claimed as exempt, select the checkbox “Claimed as 
 Exempt.” The screen will once again change and ask for additional 
 information pertaining to Schedule C. 

Figure 4 
  
 
 

To complete the Schedules, take the following into account: 
  

(A) If you selected Personal as theCategory of Property, a list of 33 different types of  
property become available. Select a type of personal property from the list by clicking 
on the up or down arrow located on the screen. 

  
(B) If you checked “Claimed as Exempt” a box appears in the Schedule Specific 

Information. Note that there is a small button located next to this box. This button 
allows you to view a list of exemptions. 
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This list includes the federal exemptions. You may add state exemptions if needed. When 
you select this button a list of exemptions will appear.  To select an exemption use your 
mouse to highlight the exemptions, then select            .  You have the options of 
adding the exemption(s) now or accessing a list form another system (if available). 

  
To Add Exemptions: Whether you are adding the specific exemption you need now or  
all the exemptions for future reference, follow these rules: 

   
(a) Select         from the Exempt List box then select the 

                        button.  

(b) A small box appears.  Type the exemption in it and select . 

   (c) Repeat the process to add other exemptions. 
    

(d) When you have finished, select                  on the Exempt List 
   screen to return to the Property Screen. 
 
  NOTE: To modify or delete an exemption from the list, select the exemption in 
  the Exempt List Screen, select        (See Figure 5). 
 

(See Figure 5) 
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IMPORTANT! When you have completed the information on the first type of property, select 
the + on the Navigator to add another entry or the check mark on the Navigator to save the entry. 
Then select Exit on the Menu Bar. 

  
NOTE! If you have listed several types of property you may wish to review, edit 

    or delete entries using the Navigator. Review the information in  
    Chapter 1 on Using the Navigator. 
  

Important View Options: Choose VIEW in the menu bar to see Real 
    Property, Personal Property, Exempt Property and All Information 
                        entries. When you select one of these options only the information about 
    that option becomes available in the Navigator, (e.g., if you select Exempt 
                         Property from the View menu, only entries pertaining to Exempt Property 
    can be accessed via the Navigator.  Select All Information, and all the 
    information for all types of property becomes available. 
   
 

NOTE! All information is the default selection the program automatically selects. 
  

5. When you have finished entering and reviewing the property 
    information you have the option of printing the Schedule(s) now or 
    waiting to print them with all other forms later. 
    

6. To print, refer to Chapter 3:  Printing... When you are sure that your 
    printer has been set up correctly, select Printing from the menu bar with 
    your mouse.  Next, select Print from the menu selections, using your 
    mouse and choose the Schedule you would like to print.  To exit to the 
    Schedules Menu, select Exit from the menu bar using your mouse. 

 NOTE!  The system automatically saves each entry when + in the Navigator is selected. 
   However, if you forget to save the last entry, by pressing the check mark in the 

Navigator, and exit to the Schedules Menu, you will be asked if you wish to 
save your last entry before exiting the Property data entry.  Select the  
                    EXIT option in the Schedules Menu to exit to the Main Menu. 

 Processing Creditors, Debtors and Co-Debtors Schedules 

 1. Select CREDITORS, DEBTORS, CO-DEBTORS (D, E, F, H) from the 
 Schedules Menu. 

 NOTE!   You should have already selected or added your client and the client’s name 
    should appear on the Schedules Menu screen. 

 2. A screen appears with the client’s name at the top, followed by three tabs: 
 Creditors, Codebtors and Declaration Concerning Schedules (See
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 Figure 6). Each tab represents a different data entry screen. The first two 
 screens, Creditors and Codebtors are dynamic and therefore utilize the 
 Navigator, (see Chapter 1, Using the Navigator). The Declaration screen  
 is static.  To get from one data entry screen to another, click on the  
 appropriate tab. 

 Figure 6 

 To enter creditor information, select a type of creditor (secured, unsecured priority, or 
 unsecured unpriority). The specific information section of the screen changes depending 
 on which type of creditor you select.  Next, select whether there is a co-debtor, the 
 person(s) liable for the claim, whether the claim is contingent, unliquidated or disputed, 
 and the creditor’s account number. You may notice a small button next to the creditor’s 
 name .  It enables you to access a list of common creditors . T his list is created in your 
 office, either through the Schedules screen or in Utilities (refer to Chapter 6: Utilities for 
 more information on creating the Common Creditor Database.  When you select a 
  creditor from this list, highlight the name of the creditor and select                     . The 

  creditor’s name and mailing address will automatically appear in the appropriate area in 
  the Creditors screen.
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NOTE!  If the list of Common Creditors is located in a different directory or on a 
 different system in your office, you can access it by selecting the Options pull-down 
 menu in the Creditors screen. 
 If the current creditor is not available on the list (or if no list has been entered) you can 
 add the creditor through the Creditor screen. To do this, enter the creditor’s name and 
 mailing address in the appropriate area on the Creditor screen, select the small button 
 next to the creditor’s name and then select the button. 

 NOTE!  Creditors cannot be deleted or edited in this manner. Refer to the section in 
 Utilities about the Common Creditor Database for instructions on changing or deleting 
 creditors from the list of common creditors. 

 3. Next complete the Schedule Specific Information area and then select 
 in the Navigator to enter another creditor or the in the Navigator to 
 save this entry.  Whenever you select the in the Navigator, your entry 
 is saved.  Continue entering creditors and select the to save your last 
 entry. 

            View Options: The VIEW pull-down menu in the menu bar gives you the    
option of viewing Secured Creditors, Unsecured Priority Creditors, 
Unsecured Unpriority Creditors and All Information entries. When you 
select one, only the information about that option is available in the 
Navigator. (e.g., Select Secured Creditors from the View menu; only 
entries pertaining to Secured Creditors are accessed by the Navigator.  
Select All Information, and information for all types of creditors is 
available. 

 
 NOTE!  All Information is the default selection. 
 

4. If there are no codebtors, skip this section and go on to the next. To 
    <enter> Codebtor information for Schedule H, click on the Codebtor tab 
    on the screen. The Codebtors screen appears listing the first creditor with a 

codebtor on the account. Each creditor you checked, the Codebtor box appears  
in the Codebtors screen. Type the name and address of the codebtor and then  
select         the on the Navigator and your information is saved. 
 

NOTE!   You can add codebtors by selecting         in the Navigator. To access the list of Common 
Creditors, select the        next to the Creditor Name field. (Refer to item #3 in this section for more 
information on using the list of Common Creditors). 
 

5. Click on the Decl.  Concerning Scheds. Tab and the Declaration screen 
    appears. Fill in the appropriate information about the current bankruptcy, 
    using the scroll bar on the right to view the entire screen. 
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   6. When you have completed all the appropriate information needed on the 
 screens for creditors, debtors and codebtors, you can print the Schedule(s) 
 now or wait to print them with all other forms. 

 To print, refer to the Chapter 3 printing chapter to set up and align your printer. 
 When your printer is correctly set up, select Printing from the menu bar with 
 your mouse.  Next, select Print from the pull down menu with your mouse and 
 select the schedule you would like to print.  To return to the Schedules Menu, 
 select EXIT from the menu bar. 
 
 

NOTE! The system automatically saves each entry when you select in the Navigator. However,  
if you forget to save the last entry (by pressing in the Navigator), and exit to the Schedules  
Menu, you will be asked if you wish to save your last entry before exiting the Property data entry. 

 7. Select the EXIT option in the Schedules Menu to return to the Main 
 Menu. 

 Processing Schedules for Income, Expenditures, Contracts and Leases (G, I, J) 

 1. Select INCOME, EXPENDITURES, CONTRACTS & LEASES (G, I, J,) 
 from the Schedules Menu. 

 2. A screen will appear with three tabs. Each tab represents a different data 
 entry screen for income, expenditures, and contracts and leases. The 
 Income and Expenditures screens are both static screens. Enter data in the 
 required fields.  The Contracts and Leases screen, on the other hand, is 
 dynamic and requires the use of the Navigator (see Chapter 1). 

 3. The Income screen appears on the top when you select INCOME, 
 EXPENDITURES, CONTRACTS & LEASES (G, I, J) from the 
 Schedules Menu. Complete the income information required for the 
 debtor, spouse and dependents (if applicable) to process Schedule I – 
 Current Income of Individual Debtor(s).  

                     NOTE! You do not need to type the $ sign in the amount columns. The columns labeled 
“spouse” must be completed in all cases whether or not a joint petition is filed, unless the  
spouses are separated and a joint petition is not filed. 

 4. Select the Expenditures tab to complete Schedule J – Current Expenditures 
 of Individual Debtors. Note that there are two buttons in the top left-hand 
 corner of the screen (Debtor & Spouse). Selecting one enables you to 
 enter and view the debtor’s or the spouse’s expenditure information in 
 cases where the spouse maintains a separate household and a separate 
 Schedule J is filed. (Be sure to check the check-box located near the top of 

is screen indicating that this is the case). Complete the information about the 
debtor’s expenditures; then select the spouse button and complete the 
information on the spouse’s expenditures (if a separate Schedule J is filed). 
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5. Select the Contracts and Leases tab to process Schedule G – Executory 
    Contracts and Unexpired Leases.  A dynamic data entry screen appears to 
    enter all executory contracts and unexpired leases of real and personal 
    property.  Enter each contract and lease, being sure to include the name, 
    mailing address, etc. Use the         on the Navigator to add each entry. 
    Press the on the Navigator to save your last entry before leaving this 

screen. When you have finished entering each executory contract and 
unexpired lease, you have the option of printing the Schedule(s) now or 

    with all other forms later. 

 6. To print, refer to the printing chapter to set up and align your printer. 
 When your printer is correctly setup, select Print from the menu bar with 
 your mouse.  Next, select Print from the menu selections with your mouse 
 and select the schedule you wish to print. To return to the Schedules 
 Menu, select EXIT from the menu bar using your mouse. 

 NOTE!  The system automatically saves each entry when the Navigator is selected. 
 However, if you forget to save the last entry and try to exit to the Schedules Menu, you 
 will be asked if you wish to save your last entry before exiting the Property data entry. 

 7.        Select the EXIT option in the Schedules Menu to return to the Main  Menu. 

 Accessing Summary of Schedules 

 
   1. Select SUMMARY OF SCHEDULES in the Schedules Menu to view, 
    edit and print the Summary of Schedules.  You will be asked to confirm 
    whether you would like the system to re-calculate the Summary  of 
    Schedules totals from the existing Schedule information. Select YES or 
    NO to continue.  The program automatically does the math and calculates 
    the number of pages. A        next to each schedule indicates whether each 
    schedule is attached. In the bottom left hand corner of the screen is a 
    button entitled Instructions. Selecting this button brings up the General 
    Instructions for the Summary of Schedules. Review these general 
    instructions first.  The program automatically checks all the boxes that 
    apply.  The operator can override information on the Summary. Check 
    the instructions and change or add any information as necessary. 

 2. You can print the Summary of Schedules  now or print them with all other 
                                               forms later. 
    

3.        To print, refer to Chapter 3: printing to set up your printer. When your printer  
            has been correctly set up, select the Printing from the menu bar with your mouse.   

Next, select Print from the menu selections using your mouse. To exit the Main  
Menu, select Return from the menu bar using your mouse. 
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4.  Select the EXIT option in the Schedules Menu to return to the Main Menu.  

  

Figure 7 

 When you select the MISCELLANEOUS FORMS option in the Main Menu a second 
 menu appears with the names of other Bankruptcy form such as Exhibit “A”, Chapter 7 
 Statement of Intention, SFA Signature Sheet, etc. Most of these are static forms ( i.e., 
 screens that closely match the actual form .)  Enter the required information in the data 
 entry fields provided. The only data entry screens that are not static are the Reaffirmation 
 Agreement and the Equity Security Holders.  In addition, there is an option on this menu 
 to access other forms.  These forms include the Federal Bankruptcy Cover, Designation 
 of Agent, and Verification of Creditor Matrix. These forms are static. 

 1. The 20 Largest Unsecured Creditors screen includes a NOTES button to 
 access notes to the 20 Largest Unsecured Creditors Report . 

 2. In the Disclosure of Compensation of Preparer the Balance Due column is 
 automatically calculated. 
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 Each miscellaneous form can be printed at the time you enter the data by simply selecting 
 the FILE pull-down menu in each data entry screen and select PRINT or PRINT 
 PREVIEW.  However, you will need to be sure that your printer is correctly setup. If 
 you are unsure of the status of your printer setup refers to Chapter 3: Printing. 

 To return to the Miscellaneous Forms Menu from any data entry screen, select the EXIT 
 pull-down menu and choose whether you would like to save changes or not. 

 To return to the Main Menu choose the EXIT option in the Miscellaneous Forms Menu 
 (See figure 7.) 

 Processing the Statement of Financial Affairs 

Figure7 

 The Statement of Financial Affairs provides information about the debtor’s recent 
 financial transactions, such as payments to creditors, sales or other transfers of property 
 and gifts.  The Statement of Financial Affairs data entry screen allows you to enter data 
 for either Personal or Business filings. This entry screen is dynamic and therefore 
 requires the use of the Navigator (see Chapter 1). Using the Navigator within this screen 
 enables you to enter several categories of financial affairs. 
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 To Prepare a Statement of Financial Affairs: 
 
   1. Select STATEMENT OF FINANCIAL AFFAIRS from the Main Menu. 
    NOTE!  You should have already selected your database and client and 
    the client’s name should appear on the Main Menu. 
 
   2.        The Statement of Financial Affairs screen will appear (see Figure 8).  First 
                                    select the type of bankruptcy being filed (Personal or Business). 
 
   3. Next select a category from the Statement of Affairs Category box. There 

are 18 different categories of financial affairs in a consumer filing, and  
25 in a business filing. To select a category, click on the up or down arrow 
in the box next to the number 01. 

    The information in the Category box will change depending on the 
    number selected. In addition, the data entry fields located on the bottom of 
    the screen will also change according to the category selected. 
  

4. Enter the required information in the data entry fields at the bottom of the 
    screen and then press        in the Navigator to add another entry to the 
    category (or the check mark to save the last entry). 
. 
   5. When you have finished entering all the appropriate categories for the 
    current Statement of Financial Affairs, you can print the Statement now or 
    wait to print it with all other forms. To print, refer to the printing chapter 
    to set up and align your printer.  When your printer has been correctly set 
    up, select Print from the menu selections using your mouse. To return to 
    the Main Menu, select EXIT from the menu bar using your mouse. 
 
 

NOTE!  The system automatically saves each entry when the on the navigator is 

  selected. However, if you forget to save the last entry, press the  on the Navigator, 
  and Exit the Main Menu. The system will also save the last entry.  However, it is 
  recommended that you use the save button in the Navigator. 
  

Mailing Lists 

 Many districts require entries to be printed on the top of the Creditor Mailing List, such 
 as debtor’s name and social security number, taxing authority, debtor’s attorney, etc. The 
 Mailing List section of Blankrupter allows you to prepare a mailing list of all creditors 
 and other address/information specified by the courts. The mailing list is printed in 
 several formats and may be delivered on a diskette in ASCII format. 

 When you select MAILING LISTS from the Main Menu a second Mailing List Menu 
 appears listing three options (Additional Entries, Print Mailing List, or Exit). 
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 To Add Unique Entries at Top of the Creditor Mailing List: 

 Figure 9 

 1. Select ADDITIONAL ENTRIES from the Mailing List Menu. A 
 dynamic data entry screen appears to add names and information to the 
 Creditors mailing list.  You can also control the order the entries appear in 
 the screen.  To add an entry, type the account number (if applicable), then 
 the name, address/social security number.  The name automatically 
 appears in the box on the right. 
 

2. Select           in the Navigator to add another unique entry. 
 

 NOTE!  Each entry appears above the last one.  To start each new entry at the bottom 
 of the list, select the red down arrow in the Navigator. Use the backward and forward 
 arrows in the Navigator to review your entry. If an entry happens to be in the wrong 
                        location, you can use the        button in the Navigator to delete the entry and then enter 
 it again in the correct location. 
 
  3. When you have finished entering additional entries, select         in the  
   Navigator to save your changes, then select EXIT in the menu bar. 
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 To Print, Convert and Save the Mailing List: 

 Figure 10 

 1. Select PRINT MAILING LIST from the Mailing List Menu . 

 2. A screen will appear listing several options for printing and converting/ 
 saving the mailing list, including: Label Type, Label Format, Number of 
 spaces between each label, save the mailing list as either an ASCII Text 
 File/Magnetic Media or an ASCII Comma Delimited Text File, Print or 
 Exit. Choose the label type and format to print mailing labels, or one of the 
 ASCII formats to convert/save your mailing list. 

 NOTE!  If you choose to save the mailing list in one of the format, a separate “”Save/ 
   File As …” dialog box will appear.  This is the standard Windows screen that 
   Specifies where you want to save the name and location of your file. 

 2. Select EXIT to return to the Mailing List Menu and then EXIT again to 
 return to the Main Menu. 
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 CHAPTER 3:  PRINTING THE FORMS 

 Whether you are printing each form at the time you enter it or all the forms at once, be 
 sure that your printer is correctly set up.  Forms can be printed through each data entry 
 screen, the PRINT PREVIEW screen option or from the PRINT FORMS screen.  The 
 Printer Setup option is available through the OPTIONS pull-down menu in the PRINT 
 FORMS screen or the PRINTING option in each data entry screen. 

 To Setup Your Printer 

 Select PRINTER SETUP from the FILE pull-down menu in the data entry screens. The 
 system will choose the current printer selected by the Windows Print Manager as the 
 default printer.  To set up a different printer, select Specific Printer in the Print Setup 
 screen and then choose a printer and location. 

 NOTE!  Make sure that the orientation and paper size are correct. 

 REFER TO YOUR PRINTER OR WINDOWS USER GUIDES FOR MORE 
 INFORMATION ON USING THE PRINT MANAGER. 

 To Print Several Forms at One Time: 

 Select PRINT FORMS from the Main Menu. A separate PRINT FORMS screen will 
 appear.  You can select each form by clicking on the form name or choosing the blue 
 SELECT ALL OTHER FORMS and/or SELECT ALL SCHEDULES as appropriate. 

 NOTE! You can tell a form is selected when it turns a lighter color… 

 Once you have chosen the forms, select the PRINT button. To reverse a choice, click on 
 the form name or the DESELECT ALL SCHEDULES or DESELECT ALL OTHER 
 FORMS buttons. 

 Select the EXIT button to return to the Main Menu. 

 Print Preview 

 Forms may be viewed on the screen as they will appear on paper.  This is done by 
 selecting “PRINT PREVIEW” from the “FILE” menu option. 

 After viewing the form on the screen and verifying its contents, you may print the form 
 from the “PRINT PREVIEW” screen by pressing the  PRINT button. 
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  CHAPTER 4:  Electronic Filing 

 This process will allow you to generate an electronic document containing all the forms 
 you request.  The electronic document is generated in PDF format. This PDF document 
 may be viewed using Adobe Acrobat, or Adobe Acrobat Reader. 

 To build a PDF file of the bankruptcy you must set up your Blankrupter to do so. 

 When electronic filing is required, a PDF file of all or selected bankruptcy files can be 
 built. 

 From the Print Forms Screen, select the forms you want included in your electronic 
 filing, check the yes button under Electronic Filing, enter the Electronic Signatures (see 
 notice below) and press Print. 

 NOTE ELECTRONIC FILING! 

 

 The electronic signatures usually consist of the characters “S/”, electronic signature, 
 followed by the full name.  Please check with your Bankruptcy Clerk for details as to 
 how your district designates electronic signatures. You will also be asked if you want to 
 create a Debtors File. This is the file that is used in Case uploads and should be sent 
 along with the PDF file that is created and if required, a copy of the creditors matrix in 
 text format ( Magnetic media). 

 If local forms are required, they can be generated in PDF format and merged to the 

 primary bankruptcy PDF file using the Merge button. 
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  To build PDF file, first create the primary PDF file using Blankrupter. After the user has 
  a primary bankruptcy file they may then add (merge) their local PDF file to the primary 
  file in the order shown on the screen.  To change the order use the up and down 
  buttons. To perform the merge and generate a new file press the Merge PDF’S button. 
  
 
 
 

 
 
 

After pressing the Print button, you will be presented with the screen below.  From this 
 screen, select File and then from the format box select Adobe Acrobat Document. Then 
 click on the little diskette icon to select the location and the name of the file. 
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From the PDF Render Screen, select OK to create your PDF.  You may use the 
  Background, Content and Compression to adjust the look and size of the PDF file that 
 will be generated. 
 NOTE! If you are saving your PDF to a 3 1/2 “ floppy, remember they only hold 1.4 
 MB of data. 
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 CHAPTER 5:  SPECIAL FEATURES 

 Setting up and selecting the Client Default Information 

 Once you become familiar with this software, you can save time by setting up default 
 client information.  This is information common to all bankruptcies filed, such as 
 attorney and firm name, district, etc.  This information can be entered once and then be 
 added to each new client without entering it again. 

 To Enter the Default Client Information: 

 Select “! _Default Information” in the Client box, then enter the default information 
 throughout the system (i.e., go into each screen and enter default information). Each time 
 a new client is added, the system will ask you if you would like to add the default 
 information.  Choose YES to do this. 

 Accessing the Windows Calculator 

 Select the F8 key on your keyboard to bring up the Windows Calculator. 

 NOTE! This option is only available when you are in a data entry screen. 

 To remove the calculator press Alt F4 or select close. 

 Short-Cut Exit From Data Entry Screen 

 Select F4 to exit any data entry screen. 

 Editing and Deleting a Client File: 

 1. Select the ATTORNEY/CLIENT file from the Main Menu. 

 2. Double-click on the name of the database (directory) that contains the 
 client you would like to edit or delete. 

 3. Select the client name to edit or delete from the list of clients in the Clients 
 box. 

 4. To edit client information, being processing as normal (i.e., exit to Main 
 Menu and then go to the screen that contains the information you want to 
 edit).  Select the DELETE button to delete the client from the database. 
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 CHAPTER 6: UTILITIES 

 To access the Utilities options: 

 Select UTILITIES from the Main Menu . 

 A Utilities screen will appear with a series of tabs at the top of the screen.  Each tab 
 represents a different option, which will be described below. To select an option, select 
 Tab and a data entry screen will appear. 

 Common Creditors Utility Option: 

 This option allows you to create, copy, move, or delete a list of common creditors. Select 
 a database containing a list of common creditors, or add/delete/modify creditors from an 
 existing list of common creditors.  This list is created by you, or someone in your firm, 
 for use every time you process a bankruptcy. It is recommended that you create a list of 
 Common Creditors as soon as possible once you become familiar with the program. This 
 will save a lot of time in the future and allow other users to access the list. This list can 
 be edited, deleted or modified at any time through this Utility.  In addition, you also have 
 the ability to add a creditor to the list in the Creditors, Debtors, Codebtors screen.  To 
 edit, delete, modify or add Common Creditors, select an option from the list of options 
 and follow the instructions on the screen. 

 NOTE! You can enter more than one Common Creditor database into the system by 
 changing the directory name. 

 CHAPTER 7: Data Conversion from an Earlier Blankrupter Program 

 Data Conversion 

 If you have been using a pervious version of Blankrupter, like version 2.7, and would like 
 to use those clients from the previous version in your Blankrupter 4.0, you will need to 
 convert the attorney folder. This is done by going to the Attorney Client Screen and 
 select the attorney folder you were using in the previous version. 
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Upon selection of the attorney folder, if the folder has not yet been converted, you will 
  get a message stating that conversion is necessary to proceed.  Click the yes button. 
  
 
 
 
 
 
 
 
 

You will then see your clients and can begin processing bankruptcies from this attorney 
  folder. 
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 CHAPTER 8: The Means Test 
 
 The Means Test – The new 2005 Bankruptcy Act provides for three new Means Test forms,  
 22A for Chapter 7, 22B for Chapter 11 and 22C for Chapter 13. Among other purpose the  
 Chapter 7 Means Test initially determines whether the Debtor is eligible to file under Chapter 7  
 or must, instead file under Chapter 13. If the calculations show that the Debtor is not eligible  
 for a Chapter 7 filing, Blankrupter will take the user to the Chapter 13 questions. 
 
  

 
 
 The purpose of and further explanations of the Means Test is set forth in the Committee Notes 
 of these new forms, set forth below: 
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